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The Microsoft Office suite delivers a broad range of tools that
can help you achieve great results with less work. On its
own, each program in the suite provides powerful, yet easy-
to-use features that vastly simplify the process of creating
great-looking documents for home or business. The possibili-
ties become even more exciting when you integrate different
Office applications to create a single file.

The seamless integration of the various programs within
Office allows you to share tools and data to create a wide
variety of documents. In this study unit, you’ll explore the
possibilities of combining the capabilities of Word and Excel,
and Word and Access.

Office makes it easier than ever to communicate your ideas
effectively, and produce polished results in less time.
Microsoft Office provides you with the tools you need to
 succeed in today’s competitive marketplace.

When you complete this study unit, you’ll be 

able to

•    Embed an Excel worksheet into a Word document

•    Embed an Excel chart or graph into a Word 

document

•    Explain the difference between object linking and 

embedding

•    Describe the procedure for linking an object to a 

Word document

•    Use Microsoft Access to create a data source

•    Develop a form letter with form fields

•    Merge a database with a form letter
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Remember to check your student portal regularly. Your instructor may

post additional resources that you can access to enhance your learn-

ing experience.
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Integrating Word with Access and Excel 1

THE MICROSOFT OFFICE SUITE
A software suite is a group of software programs sold together
in one package. Microsoft Office is one such suite. The pro-
grams in Office are designed to work independently and in
conjunction with the other programs in the suite. With a suite
like Microsoft Office, you can create documents and projects
using the tools best suited to your individual tasks.

Sometimes, however, you may need the capabilities of more
than just one software tool for a project. With Microsoft
Office, you can create an integrated file—that is, a file that
includes information or elements created by two or more
software tools.

In this study unit, you’ll explore many software functions as
you create projects that really make the most of your Office
suite. You’ll combine the power of Word and Excel to create an
invoice with an embedded worksheet that automatically calcu-
lates the total amount due. You’ll also study the procedure for
embedding an Excel chart in a Word document. Finally, you’ll
combine Word and Access to create a database address list
with a form letter to produce a personalized mailing.

As you’ll soon see, not only do integrated functions give you
access to the power of two or more programs at once, but
they also allow you to share information among several files.
Once you understand the basic ways in which the different
Office applications interact, you’ll probably be able to come
up with dozens of practical applications to streamline your
own work.

OBJECT LINKING
AND EMBEDDING
Object linking and embedding (OLE) is a special feature of the
Windows environment that’s supported by all Office applica-
tions. OLE allows you to add information from one type of
file to another (embedding), or you can share data within two
or more files (linking). (You’ll learn more about the differences
between linking and embedding as you proceed through this
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study unit.) Data that’s integrated in either of these ways is
called an object. The typical Office user works with a variety
of different types of objects, such as

• Clip art and fancy lettering

• Spreadsheets and charts

• Datasheets and reports

• Formatted text from word processing documents

OLE has a wide range of practical applications within the
Office environment. For example, you can embed an Excel
worksheet into a Word document. Then you can use Excel’s
calculation features in the word processing environment. Or,
you can illustrate a letter with a graphic from the ClipArt
Gallery and touch up your artwork without leaving Word.
In this study unit, you’ll be concentrating on linking and
embedding between Office software tools, but OLE also
works with many other Windows programs, allowing you to
integrate your documents in a wide variety of ways.

The original file linked or embedded in a document is known
as the source file. The file into which the object is embedded
or to which the object is linked is known as the destination
file. Linked objects and embedded objects differ mainly in
terms of where the data included in the object is stored and
how the object is updated after being placed in the destina-
tion file. 

When you embed an object in a file, you first create a file in
one application and then insert (embed) an object from
another application into the first file. For example, you can
create a Word file and embed a spreadsheet in the Word file.
Embedded objects become part of the destination file and,
once inserted, are no longer part of the source file. You can
edit an embedded object only by opening the destination file
and double-clicking the embedded object to make it active.
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Creating an embedded object is a matter of following a few
simple steps:

1. Open a Word document.

2. On the Insert tab, click Table and select Excel
Spreadsheet  (Figure 1).

3. Click Excel Spreadsheet. The object will appear as a
source file, surrounded by a border showing that the
object is active and can be edited or modified (Figure 2).

FIGURE 1—Embedding an

Excel Worksheet

FIGURE 2—The embedded object appears.
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If you modify the source file from within its source applica-
tion—for example, updating a linked spreadsheet by opening
the workbook in Excel—the changes will appear in the linked
object in the destination document. To modify the source file
from within the destination document, double-click the
object to open it within the source application.

In summary, an embedded object doesn’t exist as a separate
file outside the host document. A linked object exists in the
application in which it was created and in the application to
which it’s linked.

For your first project, you’ll create a common integrated file
relationship—an Excel worksheet embedded in a Word docu-
ment. This particular integration allows you to access the
powerful calculating ability of Excel while you’re using Word
to create a memo, letter, invoice, or report.

WORD PROCESSING WITH
AN EMBEDDED WORKSHEET
In the sections that follow, you’ll create a standard invoice
using Word. Once you get to the numerical portion of the
invoice, you’ll embed a blank Excel worksheet in the file.
Then, while you’re in the word processing window, you’ll
actually use Excel to calculate the total amount due.

Creating an Invoice Heading
In this section, you’ll begin to create a Word document for a
standard business invoice. Just follow these steps:

1. Open Microsoft Word and create a new blank document
(Figure 3).

2. Click the Center button in the Home tab.

3. Click the Bold button.

4. Click the Font arrow. A drop-down menu of available
fonts appears.

5. Click Times New Roman.

6. Click the Font Size arrow. A drop-down menu of font
sizes appears.
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7. Click 12 to select a new size font.

8. Press the Caps Lock key.

9. Type the word INVOICE.

10. Press the Caps Lock key to turn off that feature.

11. Click the Bold button to turn off that attribute.

12. Press the Enter key twice.

13. Click the Left Align button.

Now move directly to the next section to create an automatic
date.

FIGURE 3—The opening Word screen is a blank document.



Inserting an Automatic Date
Your computer has a battery-operated clock that keeps track
of the date and time—even when the computer is off. Follow
the steps below to insert the current date at the top of your
invoice, and set the clock to update automatically each time
you print the document in the future.

1. Click the Insert tab. 
2. Click Date & Time. The Date and Time dialog box

appears (Figure 4).

3. Click the third option in this list—the standard long date
that typically appears in business correspondence. Your
dialog box should display the current date.

4. Click Update automatically to select this option.

5. Click OK. The current date appears in the document.

6. Press the Enter key twice.

Adding Text
In this section, you’ll input most of the body text of your
invoice. Follow the steps below to enter the text of the invoice
beneath the date.

Integrating Word with Access and Excel6

FIGURE 4—Use the Date

and Time  dialog box to

automatically insert the

date.
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1. From the Home tab, click on the Line Spacing icon
in the Paragraph palette and click 1.5 (Figure 5).

2. Type the name Ms. Lydia Cordero.

3. Press the Enter key.

4. Type the company name: Global Transportation
Services.

5. Press the Enter key.

6. Type the street address: 801 South Main Street.

7. Press the Enter key.

8. Type the city, state, and zip code: Des Moines, IA
50340.

9. Press the Enter key twice.

10. Type the abbreviation Re:. This standard business
 abbreviation means regarding or in reference to. It’s typi-
cally used at the beginning of a letter, memo, invoice, or
legal document to indicate the primary subject matter.
Press the Spacebar.

11. Type the subject: Acme Merchandising Company
Sales Meeting.

12. Press the Enter key four times.

13. Type Payable to:.

14. Press the Enter key twice.

15. Type Peter Pavlov.

16. Press the Enter key.

17. Type 42 First Avenue.

18. Press the Enter key.

19. Type Des Moines, IA 50340.

20. Press the Enter key.

When you’re finished typing the text, compare your screen
with Figure 6. Afterwards, proceed to the next section to
name and save your invoice in the Documents folder of your
hard disk. (You’ll be saving all of your projects in this folder
during the course of this study unit.)

FIGURE 5—Line

Spacing Icon
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Naming and Saving a Document
Complete the steps that follow to name and save your
 document in the Documents folder.

1. Click the diskette icon in the upper-left corner.

2. Click Save As (Figure 7). The Save As dialog box appears.
This dialog box appears because the document hasn’t
been saved before. 

3. If the Documents folder isn’t already displayed in the
Folders box, follow this procedure:

• Click Browse.

• Double-click to select the Documents folder from
your hard-disk directory.

4. Note on your screen that Word has suggested the name
INVOICE in the File Name box.

To modify the document name, follow the procedure begin-
ning on page 9.

FIGURE 6—The Word screen shows the body text of the invoice you’re

creating.
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• Click to the right of the word INVOICE in the File
name box.

• Press the Spacebar.

• Type Acme (Figure 8).

• Click Save.

FIGURE 7—To save your document, click Save As.

FIGURE 8—Type in

the File name box to

change Word’s auto-

matic file name

suggestion.
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   This procedure saves the file on your computer’s hard
disk as INVOICE Acme. This name now appears in the
title bar of the document window (Figure 9).

5. To exit Word, click that program’s Close button—the
square button marked with an “X” in the upper-right
corner of your screen. You can then quit Windows to
end your work session or move directly to the next sec-
tion to reopen your invoice and add a worksheet.

Embedding a Blank Worksheet
Now that you’ve completed the basic text portion of the invoice
using Microsoft Word, you’re ready to calculate your invoice
total using an embedded worksheet from Excel. Instead of pick-
ing up a pocket calculator or a pencil and paper to do the
math, you can call on Excel to handle the calculation. Follow
these steps to reopen the Word file INVOICE Acme and embed a
blank worksheet in this document.

1. Open Microsoft Word.

2. In the left panel, click INVOICE Acme to open the
document.

3. If you don’t see INVOICE Acme in the left panel, click
Open Other Documents at the bottom of the left panel.
The Open dialog box appears, and you can choose from
that window or browse the computer.

4. Double-click the filename INVOICE Acme. The
 document window displays your invoice.

5. Click immediately to the left of the abbreviation Re:. The
insertion point appears immediately to the left of the
abbreviation.

FIGURE 9—The name of the document now appears in the title bar.
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6. Press the Down Arrow key twice. The insertion point
moves to the blank space halfway between the Re: line
and the Payable to: line.

7. On the Insert tab, click Table and select Excel
Spreadsheet (Figure 10).

8. Click OK to embed a new blank worksheet in the docu-
ment window (Figure 11).

If necessary, you can use the down scroll arrow in the lower
right-hand corner of the document window to bring the
whole worksheet into view. The new worksheet automatically
displays 7 columns (A–G) and 10 rows (1–10). Since the
worksheet is now active, the toolbar options display Excel
functions. Now move directly to the next section to reduce
the size of this worksheet.

FIGURE 10—Select

Microsoft Office

Excel Worksheet in

the Object dialog

box.
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Resizing an Embedded Worksheet
It’s easy to change the number of columns and rows displayed
in a worksheet by resizing it with your mouse. Follow these
steps to remove two columns from your worksheet.
1.  Position the mouse pointer on the small black resizing

handle at the center of the worksheet’s right side, which
you can see on your screen and in Figure 11. When you
point directly at the handle, the mouse pointer changes
to a double-arrow pointer.

2.  Click and hold the left mouse button.
3.  Drag the pointer to the left until the gray, dragged line

comes as close as possible to the right-hand side of
 column E (Figure 12). Note that the dragged line may
not precisely meet the line that marks the right edge of
column E.

FIGURE 11—A blank work-

sheet is embedded in the

document.
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4.  Release the mouse button. Your worksheet has been
resized so that only columns A–E appear.

Now follow these steps to reduce the number of rows in your
worksheet.

1. Position the mouse pointer on the small black resizing
handle at the center of the worksheet’s bottom side.
When you point directly at the handle, the mouse
pointer changes to a double-arrow pointer.

2. Click and drag upward until the dragged line is level
with the bottom line of row 5. Note that the horizontal
scrollbar of the resized worksheet will mask row 5, so
there’s no need to drag the line until it’s level with the
bottom of row 4.

FIGURE 12—Drag the

border to the right of

column E.
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3. Release the mouse button. Your worksheet has been
resized so that only rows 1–4 appear. Compare your
screen with Figure 13.

The resizing handles can also be used to enlarge the work-
sheet. If you accidentally remove too many rows or columns,
simply click and drag to make the worksheet larger.

Completing the Worksheet
Now get ready to make data entries to the embedded work-
sheet. Follow these steps to complete your worksheet now.

1. Click in cell A1.

2. Type the number 45 in this cell.

FIGURE 13—Dragging the

right border has resized

the worksheet.
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3. Click in cell B1—or press either the Tab key or Right
Arrow key—to select this new cell.

4. In cell B1, type the phrase double-spaced pages at the
rate of.

5. Press the Tab key to advance to cell C1.

Compare your screen with Figure 14. Don’t worry that the
entry in cell B1 runs into the adjacent cells; you’ll adjust all
column widths later.

Before you enter data in cells C1 and E1, you should format
these cells so the values in them are displayed as currency.

1. Make sure you still have cell C1 selected.

2. On the Home tab, click the Accounting Number Format
button (the one marked with a dollar sign) in the
Number group.

3. Type the value 3 in cell C1.

FIGURE 14—The text in

cell B1 only appears to

run into the adjacent

cells.



4. Press the Tab key. Compare your screen with Figure 15.
The value in cell C1 should appear as $3.00—with a
 dollar sign, decimal point, and two zeros automatically
displayed. Note that the value in cell C1 will obscure the
text spilling over from cell B1.

5. In cell D1, type the phrase per page.

6. Press the Tab key.

7. With cell E1 selected, click the Accounting Number
Format button. 

8. In cell E1, type the formula =A1*C1. This formula multi-
plies the number of pages in cell A1 by the per-page rate
in cell C1; that is, 45 times $3.00.

9. Press the Enter key.

Integrating Word with Access and Excel16

FIGURE 15—The value you entered in cell C1 is automatically for-

matted for currency.



The result appears as $135.00 with a dollar sign, decimal
point, and two zeros automatically displayed. Compare your
screen with Figure 16.

Now you’ll proceed to create an invoice total in cell E3. Even
though there’s only one item on this invoice, it’s good prac-
tice to include a separate total in case you want to add
another item later or make a copy of this file to create a
longer invoice.

Follow these steps to calculate the total amount due for the
invoice. 

1. Click in cell E3.

2. In the Editing group, click the AutoSum button (the one
marked S—the Greek letter sigma). The AutoSum feature
automatically selects cells E1 and E2.

3. Press the Enter key. The total $135.00 appears in
cell E3.

Integrating Word with Access and Excel 17

FIGURE 16—The total appears as the result of the formula you

entered in cell E1.



Integrating Word with Access and Excel18

4. Click in cell D3.

5. Type the phrase Total Due:.

6. Press the Enter key.

You’ve now entered all the data in your worksheet. Compare
your screen with Figure 17. Then move directly to the next
section to resize the width of your columns so that your
worksheet fully displays all the data.

Adjusting Column Widths
Follow these steps to select the entire worksheet and adjust
all the column widths.

1. Click in cell A1.

2. Press and hold the Shift key as you click in cell E4.
This selects the entire worksheet.

3. Click Format in the Cells group.

4. Click AutoFit Column Width.

FIGURE 17—This is what

your screen should look

like after you’ve entered

all the data for the work-

sheet.
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The columns resize to display all the data, as shown in
Figure 18. As a finishing touch, proceed to the next section
to remove the worksheet gridlines.

Removing Worksheet Gridlines
1. Make sure the entire worksheet is still selected.

2. Click the View tab.

3. Click the check box next to Gridlines to deselect this
option (Figure 19). 

Your formatted worksheet is ready to be integrated into the
invoice document. 

FIGURE 18—Once you

resize the column widths,

you can see all the data

you’ve input.



Integrating Word with Access and Excel20

Closing the Worksheet Window
To close the worksheet window, click once in the document
window (outside the worksheet area). The Word tabs return,
and the worksheet data is embedded into the invoice text
(Figure 20).

If you wish to select the worksheet again, just double-click
anywhere in the worksheet area.

Now move directly to the next section to view your completed
document (and embedded worksheet).

FIGURE 19—The Gridlines option is selected by default, so you must deselect it.

FIGURE 20—The worksheet data is now embedded into the invoice

document.
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Using Print Preview
Let’s take a look at your completed invoice using the Print
Preview command.

Click the File tab and then Print. The Print Preview window
appears on the right side of the window (Figure 21).

Once you’ve reviewed your work, you can cancel Print Preview
mode by clicking Print to print the document or Close to
return to Normal view. You may be prompted to save changes
after clicking Close.

Saving an Integrated Document
When you save your Word document, you also save your
embedded Excel worksheet file. Follow these steps to save
your document and close Word.

FIGURE 21—Print Preview

allows you to view your

document as it will

appear when printed. 
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1.  Click the Save button in the upper-left corner. That but-
ton is marked with a floppy disk. Since you’ve already
saved your Word document (along with the embedded
worksheet) on your computer’s hard disk as INVOICE
Acme, clicking on Save simply updates the saved file
with the changes you’ve made since you last saved it.

2. Click the Word window’s Close button to exit this appli-
cation now.

Congratulations, you’ve created a truly professional business
invoice using two Office applications—Word and Excel. You
used Word to format and lay out the basic text of the invoice
and Excel to handle the math—all in a single integrated doc-
ument. You can quit Windows now to end your work session
or move directly to the next section, which explains how to
copy your document and modify that copy in creating a dif-
ferent invoice.

Modifying an Integrated Document
You truly reveal the beauty of an integrated document when
you create a new version of the file or modify the existing
version. In this section, you’ll copy and revise the invoice you
created in the last section (INVOICE Acme). Because you
took the time to embed a self-calculating worksheet when
you set up the original integrated file, modifying the file for a
different customer will save you many steps. To complete
this part of your studies, you’ll first need to open the original
invoice and make a copy of it. Open Word and then follow
the steps listed here.

1. From the Word main window, select File and click
Open.

2. The Open dialog box appears with the Recent
Documents list displayed (Figure 22).

3. Double-click the filename INVOICE Acme. The docu-
ment window containing your invoice appears.

4. Click File and then Save As. The Save As screen
appears with different options available. Click the
Documents folder you’re using, or click Browse to
find it.
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5. Click to the right of the name INVOICE Acme in the File
Name box.

6. Press the Backspace key to remove the word Acme.

7. Type the word Snacktime (Figure 23).

8. Click Save.

FIGURE 22—Click File and then Open. Look for the document named “INVOICE Acme.”
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Note that when you use the Save As command in this way,
Office automatically creates the new copy of the document.
The window title bar should now read INVOICE Snacktime.

Now that you’ve made a copy of the original file and saved it
under a new name, you’re ready to modify the invoice. The
next set of steps will guide you through modifying both text
in the Word document and the data in the Excel worksheet.

The date you inserted when you created the original invoice
will automatically update when you print (or use the Print
Preview feature). Therefore, the only change you need to
make to the rest of your new invoice is the subject in the
 reference line. Replace this text now.

1. Position your mouse pointer right before the word Acme
(just after the space).

2. Click once to create an insertion point.

3. Press the Shift+End key combination to select to the
end of this line.

4. Type the replacement text: Snacktime Foods Customer
Focus Group.

FIGURE 23—You can

save a copy of a file

by typing a new

name in the File

name box.
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The document on your screen should match the document in
Figure 24. Once they match, you’re ready to modify the
worksheet area of the invoice.

Note that before you can make changes to the embedded
worksheet, you’ll need to activate Excel.

1. To launch the Excel program, simply double-click any-
where within the embedded worksheet. A miniature
worksheet window appears within the Word document
window, and the Excel options appear.

2. Click cell A1. The number 45 appears in the  formula
bar.

3. Type the number 94.

FIGURE 24—The text of

the invoice has been

modified.
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4. Press the Enter key. Note that changing the number of
pages in cell A1 automatically changes the total in cells
E1 and E3 to $282.00 (Figure 25). That’s because you
entered a formula in both cells to calculate the invoice
total.

5. Click anywhere outside the miniature worksheet.

6. To save your changes, click the Save button.

7. Click the Word window’s Close button to exit this appli-
cation now.

You can see how easy it is to create a new version of an inte-
grated document, particularly when you’ve made the effort to
build in timesaving devices, such as dates and worksheet
formulas, which automatically update your work.

In the next section, you’ll be trying your hand at embedding
a chart in a Word document. Before going on to that section,
please take a few moments to review what you’ve just studied
by completing Self-Check 1.

FIGURE 25—Changing the

value in cell A1 automati-

cally changes the total in

cells E1 and E3.
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Self-Check 1

At the end of each section of Integrating Word with Access and Excel, you’ll be asked to

check your understanding of what you’ve just read by completing a set of “Self-Check”

questions. Writing your answers to these questions will help you review what you’ve

studied so far. Please  complete Self-Check 1 now.

1.  When you insert a new, blank worksheet into a Word document, it’s 

a. automatically embedded in the document file.

b. automatically linked to the document file.

c. not possible to edit the worksheet at a later time.

d. not visible until the document is printed.

2.  An automatic date displays the current date when you

a. click the Save button.

b. recalculate an embedded worksheet.

c. use the Print or Print Preview command.

d. open the document.

3.  The abbreviation Re: in a business document stands for

a. return receipt requested.                                c.   registered.

b. regarding or in reference to.                           d.  reply required.

4.  Before you can edit a worksheet that’s embedded in a Word document, you must

a. close all other files.

b. finalize the text in the Word document.

c. select the worksheet and then click All Characters.

d. double-click the embedded worksheet to activate Excel.

5.  The main difference between an embedded object and a linked object is that a linked object

a. exists as a separate file.

b. must be manually updated in the destination document.

c. can be connected to only one other file.

d. is usually created in a word processing application.

Check your answers with those on page 65. 
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WORD PROCESSING WITH
AN EMBEDDED CHART
You’ve already learned how to embed a worksheet into a
Word document. Now, you’re going to study the process for
embedding an Excel graph or chart within a Word document.
The procedures are very similar, but we’ll take you step by
step through the process to be sure you understand how it’s
done.

First, you’ll create a short report in Word, and then you’ll
use Excel to create a bar graph to insert into the report.
When you insert a graph or chart into a word processor
document, it’s automatically embedded into the file.

Creating the First Document
Follow these steps to create a new Word file.

1. Open Microsoft Word and create a new blank document.

2. Click the Center Align button.

3. Click the Italic button.

4. Click the Font size list arrow.

5. Click 14 to select this new size.

6. Press the Caps Lock key.

7. Type the phrase FINANCIAL REPORT.

8. Press the Caps Lock key to turn this feature off.

9. Click the Italic button to turn off that attribute.

10. Press the Enter key twice.

11. Click the Left Align button.

12. Click the Font size list arrow and choose 12.



13. Type the following paragraph: The following data sum-
marizes the income earned by Maferty Plumbing
Company during the fiscal year January to
December. The revenue and expenses for each month
are shown in the following table. A bar graph has
been included to indicate the increasing income
experienced by the business throughout the calendar
year. This increase in income was associated with
improved advertising and marketing efforts by the
company.

      When you’re finished, compare your screen to Figure 26.

14. Save your report as FINANCIAL REPORT in the
Documents folder of your hard disk.

Creating an Excel Worksheet and Chart
Now let’s add an Excel worksheet to this document.

1. With your cursor still at the end of the paragraph you
typed, press Enter twice.

2. On the Insert tab, click Table and select Excel
Spreadsheet (Figure 27).

Now, follow the steps listed here to lay out and enter data
into your worksheet.
1. Select cells A1 to D1.

2. Click the Bold button.

3. Using Figure 28 as a guide, input the column headings
in cells A1, B1, C1, and D1.
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FIGURE 26—The text of the Financial Report introduces the table and graph you’ll embed in

the report.
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FIGURE 27—A blank Excel worksheet has been embedded in the Financial Report document.

FIGURE 28—Use this worksheet as a guide to enter data into your embedded

worksheet.



4. Using Figure 28 as a guide, input the names of the
months in column A.

5. To select cells B2 through C13, click cell B2, hold the
Shift key down, and then click cell C13.

6. With these cells selected, click the Accounting Number
Format button.

7. With the cells still selected, click the Decrease Decimal
button twice. This will add a dollar sign to the values
you enter in columns B and C and delete the decimal
and two zeros.

8. Using Figure 28 as a guide, input the values in columns
B and C.

9. Click the line between columns A and B to AutoFit the
contents of Column A.

When you’ve entered all the data, proof your worksheet
entries against the ones in Figure 28.

The figures in the Income column (column D) should equal
the figures in column C (revenue) minus the figures in 
column B (expenses). Therefore, you should be able to use
formulas to calculate the Income column.
Use the following steps to calculate the figures for column D.

1. Click in cell D2.

2. Type in the formula =C2-B2. This tells the program to
subtract the value in cell B2 from the value in cell C2
and place the result in cell D2.

3. Press Enter. The figure in cell D2 should be $2,555.

4. Click in cell D2 again.

5. Aim your mouse pointer at the lower-right corner of this
cell until it changes to a plus sign (+).

6. Press and hold the left mouse button while you drag
down to cell D13.

7. Release the left mouse button, and the formula from
cell D2 will be automatically copied into cells D3
through D13. The calculations should populate the cells
in column D.

Compare your worksheet with the one in Figure 29.
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You should now be ready to create a chart that’s based on
the data you’ve input. First, however, you need to enlarge the
worksheet area. To do so, simply follow these steps:

1. Aim the mouse pointer at the lower-right resizing handle
of the worksheet until the pointer changes to a double-
arrow pointer.

2. Drag the corner to the right as far as it will go and down
until the worksheet shows 30 rows. Your worksheet win-
dow now has 9 columns (A–I) and 30 rows.

Now follow these steps to insert a chart below the worksheet.

1. Select cells A1 through D13.

2. Click the Insert tab.

3. Click Insert Column Chart in the Charts group
(Figure 30). 

4. Click the first option in the Chart Types.

Note: When working on your worksheet, if it seems to disap-
pear from your screen, double-click the worksheet and use
the scroll bars to scroll up to the top. It may take a few
attempts.

You’ll have to reposition and resize the chart following these
steps.

FIGURE 29—Once you copy the formulas to all the cells in column D, Excel

 performs the calculations for you.
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1. Make sure the chart is selected. (Double-click the work-
sheet first if you’re not in Excel mode.)

2. Click anywhere inside the chart area and hold the left
mouse button down as you drag the chart underneath
the table in the worksheet, leaving one empty row
between the table and the chart.

3. Aim the mouse pointer at the resizing handle in the
 middle of the right side of the chart and drag the side
over until the chart extends across columns A–H.

Next, you need to eliminate the gridlines from the embedded
worksheet.

1. Make sure the worksheet is selected.

2. Click the View tab.

Note: When you insert a chart into your worksheet, you can
make changes to it using the Chart tools.

3. Click the check box next to Gridlines to deselect this
option.

Finally, you can view the worksheet integrated into your
financial report (Figure 31) and exit the program.

FIGURE 30—Inserting a Column Chart 
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1. Close the worksheet window by clicking once in the doc-
ument window (anywhere outside the worksheet area).
The Word toolbars return, and the worksheet data is
embedded into the financial report text. To select the
worksheet again, just double-click anywhere in the
worksheet area.

2. Save your project and exit Microsoft Word.

FIGURE 31—Your Financial Report with Chart



Integrating Word with Access and Excel

A Look at Object Linking
You’ve already completed two projects that involved embedding
an Excel worksheet into a Word document. You also learned
how to modify a document that contains an embedded
object. As you may remember, you had to open the Word
document to modify the embedded worksheet. You couldn’t
edit the worksheet as a separate file because it’s part of the
Word file in which it’s embedded.

Now you’re going to study how to link an object to a Word
document. As you read this material, you’ll discover how
similar the procedures for linking and embedding are. (Since
these procedures are so similar, we won’t go through the
linking process in as much detail.)

Here are the basic steps for creating an integrated document
involving a link:

1. Open Excel to create a source worksheet.

2. Turn back to Figure 29 and use that illustration as a
model for entering data into the new worksheet.

3. When you’ve finished entering the data, save the work-
book as New Summary in the Documents folder on
your hard disk. Note that the worksheet will appear in
your folder with an .xlsx extension.

4. Close Excel.

5. Open Word to create a destination document. Save this
file as “NEW REPORT.”

6. Type the same title and introductory paragraph you
entered earlier when you created the document named
FINANCIAL SUMMARY.docx.

7. When you’ve finished entering the text, press Enter twice.

8. Click the Insert tab.

9. Click the down arrow next to Object.

10. Click Object. The Object window will open (Figure 32).

35
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11. Click the Browse button to the right of the File name:
field and find your New Summary file.

12. Select your New Summary file and click Insert.

13. Click OK. The worksheet file is now displayed in your
Word document (Figure 33).

If you double-click on the linked worksheet, Excel will auto-
matically open to allow you to edit the worksheet. Any
changes you make will automatically appear in the Word
document after you close Excel. Similarly, if you open the
worksheet in Excel and make changes to the cell entries, the
changes will automatically appear in the Word document. In
this way, all related documents are accurate and contain the
same information.
You can test the process yourself. 

1. Open the file New Summary.xlsx in Excel.

2. Click in cell B2.

3. Type the value 14000.

4. Press Enter. Note that changing the value in cell B2 will
change the result of the formula in cell D2 to $3,786.

FIGURE 32—To insert an existing file into a document, click the Create

from File tab.
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5. Save your file and close Excel.

6. Open the file NEW REPORT.docx in Word. A dialog box
asks whether you want to update links. Click Yes. If you
examine the linked worksheet, you’ll see that the
January expense and income values have been updated.

You can see how easy it is to make changes once you estab-
lish a link between two files. This feature seems even more
magical when the Excel document is linked to more than one
Word document. When you update the Excel file, all the
linked documents will be updated automatically.

Although linking takes time to set up, it pays off when you
need to update information quickly and easily. Take the time
to explore linking and embedding to determine how you can
use these powerful functions  in your own  projects.

In the next section of this study unit, you’re going to explore
the procedure for creating a mail merge—a tool used in busi-
nesses of all types and sizes. Before you go on, however,
please complete Self-Check 2.

FIGURE 33—The linked worksheet appears in the Word document.
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Self-Check 2
1.  True or False? Before you embed an object in a Word document, you must create the

object in another software application.

2.  If you want to embed an object in a Word document, what button should you select from

the menu bar? 

        __________________________________________________________

3.  What button on the Excel toolbar should you use to add a dollar sign and two decimal

places to a number in a cell? 

        __________________________________________________________

4.  If you type =C2+D2 in a cell, what will be displayed in that cell? 

        __________________________________________________________

5.  How can you change the size of an embedded Excel worksheet? 

        __________________________________________________________

Check your answers with those on page 65.
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MERGING A DATABASE 
WITH A FORM LETTER
Many times businesses want to send the same message to a
number of people or other businesses. At such times, these
businesses use a form letter. Each letter contains the same
message, but it also contains blanks (fields) for information
that varies from letter to letter, such as the receiver’s name,
address, account balance, phone number, or any other items.

The form letter is the most commonly used integrated Office
file. You can use this type of integrated document to contact
just a few people, or you can use it to create hundreds of
letters for a mass mailing. The most efficient way to per-
sonalize a form letter is to merge information from an
address database with a standard form letter.
Simply put, here’s the process for creating a form letter:

1. Create a database that contains the personalized
 information to be inserted into each form letter.

2. Create the form letter, or main document, in Word.
(The main document for a mail merge can be a new or
existing document, a catalog, a form letter, a member-
ship directory, a parts list—just about anything. The
main document contains the text and graphics, if used,
that stay the same for each version of the merged
document.)

3. Insert placeholders into the main document. A place-
holder is an instruction directing the computer software
application to the desired data.

4. Merge the database with the main document.

Before you actually begin your form letter, get ready to create
a short database of three names and addresses to use in this
integrated project.

Data sources are used extensively in the mail merge process.
You can create a new data source either in Word or in some
other application like Excel or Access, or you can use an
existing data source. Word can use several different types of
files as data sources, including files from Microsoft Access or
Excel. Before you create a new data source for a mail merge,
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you must first determine which Office program is best suited
for your task. The choice between applications depends
greatly on the size of the list and whether or not the list will
be modified and maintained over time. For a longer list that
you expect to change, use Microsoft Excel or Microsoft
Access; for brief lists, use Word.

For the mail merge project in this study unit, you’ll use
Microsoft Access to create the database. We also include
basic instructions for creating a database directly in Word.

Creating a Mail Merge
Database in Access

Starting the Database

1.  Open Microsoft Access. The startup dialog box appears
in the Access window. 

2.  Click Blank desktop database as shown in Figure 34.
The Blank Database dialog box appears in a new window.

3.  Type Mailing.accdb in the File name box (Figure 35).
4.  Click the Create button to create a new table. The

Mailing: Database window appears (Figure 36).
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At the top of your screen, you’ll see tabs and buttons to work
on your database. The left pane contains your table, and the
right pane displays the selected table.

When creating a new database, your first task is to design
the table to identify specific types of data within your data-
base. Each single piece of data to be placed in your main
document—such as a name, address, phone number,
account balance, and so on—is referred to as a field. Follow
these steps to design the table for your database.

1. Double-click the area Click to Add.

2. Type Title and press Enter. The Click to Add field will
appear to the right so that you can continue to add
headings for the data you want to include (Figure 37).

3. Type First Name, and press the Enter key. Select
Short text.

FIGURE 34—To begin creating your database, choose Blank database.
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4. Type Last Name, and press the Enter key.

5. Type Job Title, and press the Enter key.

6. Type Department, and press the Enter key.

7. Type Company, and press the Enter key.

8. Type Address, and press the Enter key.

9. Type City, and press the Enter key.

FIGURE 35—Type the name of your database in the File name box.

FIGURE 36—The Database window displays design objects and design options. 
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10. Type State, and press the Enter key.

11. Type ZIP Code, and press the Enter key.

When you’ve finished entering the field names, compare your
screen with Figure 38.

Naming and Saving a Database

1. Click the Save Diskette icon and then Save Database As.

2. When prompted, click Yes to close all open objects
(Figure 39).

3. Type the filename Mailing in the File Name box.

4. Click OK.

FIGURE 37—Adding New Table Fields

FIGURE 38—Your table should look something like this after you’ve entered all the field names.

FIGURE 39—You’ll be

prompted to close all

open objects before

saving your work.
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Now move directly to the next section to create a handy data
entry form using a template. Although the form you’ll create
isn’t strictly necessary for data entry, it provides a clear dis-
play of individual records, which helps prevent data entry
errors.

Creating a Database Form

1. Click the Create tab in the Ribbon and then click Form
(Figure 40).

2. A new form appears with fields from your table 
(Figure 41).

FIGURE 40—The Form Button

FIGURE 41—The new form is based on the table.



Integrating Word with Access and Excel 45

Entering Data into a Form

From the Home tab, click the View button and then Form
View so you can enter data into your form. Fill out the first
mailing record in your database as shown in Figure 42. As
you type in the mailing information, you can advance from
field to field without leaving the keyboard by pressing the
Tab or Enter key. Use your mouse or press Shift+Tab to
move backward through the fields if you need to correct any
typing errors. Since a record number will automatically
appear in the ID field, you can bypass this field and begin
typing in the Title field.

Note that if you press the Enter key while your cursor is in
the last field of the record, you’ll automatically advance to
the form for the next record. You would then be able to enter
information for other records; however, we’re going to have
you complete your record entries in a different view to give
you practice with different features of Access.

When you’ve finished entering data into each field for the
first record, compare your screen with Figure 42.

To save your work, follow these steps.

1. Click the Save button. The Save As dialog box appears.

2. Leave the default name Mailing and click OK. Doing so
saves your mailing list on your computer’s hard disk.

You can now quit the application to end your work session,
or you can move directly to the next section to enter the two
remaining records.
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Entering Records 

In this section, you’ll add the second and third records to your
mailing list. If this is a new work session, start Access as
before. The startup dialog box appears in the Access window.

Follow these steps to open your database and enter the data
for your second record.

1. Click Mailing from the Recent file pane on the left.

2. Double-click the Mailing icon listed under Table in the
left pane to open it.

3. The mailing list appears. At this point, your list contains
only one record for Abner Corvell. You’ll now add infor-
mation to create two more records. Note that as you
enter data, some of the information you enter into vari-
ous fields will appear to be cut off. However, once you
finish entering data, you’ll adjust the column width for
each field to display all the information.

FIGURE 42—This is what your database form will look like after you’ve entered the data for

the first record.
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4. Click in the blank cell in the second row of the Title
 column, and type Mr. as the title.

5. Press the Enter key to advance to the First Name field,
and type Manuel.

6. Press the Enter key to advance to the Last Name field,
and type Nieves.

7. Press the Enter key to advance to the Job Title field,
and type the job title: Owner.

8. Press the Enter key twice to bypass the Department
field and advance to the Company field. Type the com-
pany name: The Treasure Trove.

9. Press the Enter key to advance to the Address field, and
type the address: 111 East Kent Street.

10. Press the Enter key to advance to the City field, and
type Jersey City.

11. Press the Enter key to advance to the State field, and
type the state abbreviation: NJ.

12. Press the Enter key to advance to the ZIP code field,
and type the zip code: 07307-5554.

13. Press the Enter key to complete this record.

Now, follow these steps to enter the data for the third record
in your database file.

1. Press the Enter key to advance to the Title column of
the next record in your database. Note how the table
automatically enters the ID number for you. 

2. Type Mr. as the title.

3. Press the Enter key to advance to the First Name field,
and type Darnell.

4. Press the Enter key to advance to the Last Name field,
and type Winston.

5. Press the Enter key to advance to the Job Title field,
and type the job title: Assistant Director.

6. Press the Enter key to advance to the Department field,
and type Product Evaluation.
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7. Press the Enter key to advance to the Company field,
and type the company name: Faraway Gifts.

8. Press the Enter key to advance to the Address field, and
type the address: 2 Cypress Avenue.

9. Press the Enter key to advance to the City field, and
type the name of the city: Monrovia.

10. Press the Enter key to advance to the State field, and
type the state abbreviation: CA.

11. Press the Enter key to advance to the ZIP code field, and
type the ZIP code: 91016-1324.

12. Press the Enter key to complete this record.

Now that you’ve entered Mr. Darnell Winston’s information
into your Mailing database, click the Save button on the
toolbar to save your three records in your database file.

You can now proceed to the next section to adjust all column
widths using the Best Fit option.

Adjusting Column Widths

1. To select all columns in your table, click the mouse
pointer in the ID column heading. The entire column
will appear highlighted.

2. Press the Shift key and click the final column  heading,
Zip Code. All rows and columns will appear highlighted.

3. Right-click your mouse, and then click Field Width. The
Column Width dialog box appears.

4. Click the Best Fit button. Each column adjusts to the
width of its longest entry.

5. Press the Ctrl+Home key combination to return to the
beginning of the table.

6. Compare your screen with Figure 43.

7. To save your changes, click the Save button.

8. Click the Access window’s Close box to exit the
 application.
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You’ve now completed the database file that you’ll use to create
a professional personalized mailing. At this point, you can quit
Windows to end your work session. Before you begin to create
your form letter, study the following section on how to create a
data source in Microsoft Word. The procedure outlined in this
section represents a general overview of the process, rather
than a listing of discrete tasks.

Creating a Mail Merge Database in Word
As we’ve already mentioned, you can create a mail merge
database in different software applications. You’ve just
completed a database using Microsoft Access. You’ll soon
be using that database for a mail merge.

When using the mail merge function, you can also create
your database directly in Word. The following steps outline
the procedure for using Word.

1. Open Microsoft Word and open a new blank docu-
ment.

2. Click the Mailings tab, click Start Mail Merge, and
then click Step-By-Step Mail Merge Wizard. The Mail
Merge Helper pane appears on the right side of the
window.

3. Select the Directory radio button and then click 
Next: Starting Document at the bottom of the pane
(Figure 44).

This series of selections tells the program that the open
Word window is where you’re going to type your letter.
However, if you choose, you can also type the letter before
you create the database. 

FIGURE 43—These are the three records included in your database file.

FIGURE 44—The Mail Merge

panel guides you through

the merge process.
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Under Select Starting Document, select the Use the Current
Document radio button. Then click Next: Select Recipients
at the bottom of the Mail Merge pane.

4. Under Select Recipients, click the Type a New List radio
button.

5. Under Type a New List, click Create. The New Address
List dialog box opens (Figure 45).

6. Scroll through the fields in the New Address List dialog
box. Since you would like to add a field called “Job
Title,” click Customize Columns.

7. Click Add in the Customize Address List dialog box.

8. Type Job Title and then click OK.

9. With “Job Title” selected, click Move Down to move this
new field below Last Name, so your fields appear as in
Figure 46.

10. Click OK.

11. Click OK again.

12. In the Save Address List dialog box, save the file as
“address list” to your Documents folder. Click Save.

13. Click OK.

14. Since you’ll be using your Access database and not this
address list in your Mail Merge, close the Mail Merge pane.

FIGURE 45—The Create

Data Source dialog box

allows you to add, delete,

and move fields.
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Creating a Form Letter
Now that your Access database is  complete and you learned
how to  create an address list in Word, you need to create a
main document to merge with this database. For this docu-
ment, you can use an already existing file, or you can create
a brand new document. You can create your own letterhead
and format the letter or document yourself, or you can use
any one of the templates provided with Word. (To access
these templates, select the Office button and New. From
the New Document dialog box, you have a choice of many
templates.)

In this section, you’ll begin a new Word document and create
the text portion of a form letter. Follow these steps to start
your mail merge.

Setting Up Your Mail Merge

1. Open a blank Microsoft Word document.

2. Under Mailings, point to Start Mail Merge, and then
click Step-By-Step Mail Merge Wizard.

3. Select the Letters radio button and then click Next:
Starting Document at the bottom of the pane. (If it
reads Step 3 of 6 at the bottom of the Mail Merge pane,
click the Previous button twice to return to Step 1.)

FIGURE 46—Word provides

a data form for you to

enter information into each

field.
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4. Under Select Starting Document, leave Use the Current
Document radio button selected, and then click Next:
Select Recipients at the bottom of the pane.

5. Under Select Recipients, select the Use an Existing List
radio button since you’re going to use your Access list.

6. Click Select Browse under Use an Existing List.

7. Locate your Mailing Access file and then click Open.
8. In the Mail Merge Recipients dialog box, make sure all

recipients are selected (boxes checked) and then click
OK.

9. Click Next: Write Your Letter in the Mail Merge panel.
Next, you’ll type your letterhead in the Word document.

Creating a Letterhead

1. Click the Center Align button on the Home tab.

2. To format the letterhead in bold text, click the Bold
button.

3. Type the company name: Natural Crystals and Fossils.

4. Change the line spacing to 1.0.

5. Press the Enter key, and type the address: 1411 Sunset
Trail.

6. Type Pryor, OK 74361.

7. Press the Enter key.

8. Click the Left Align button to cancel centering.

9. Click the Bold button to return to normal style.

10. Change the line spacing to 1.5.

Adding Body Text

1. To change to a standard typewriter font, click the Font list
arrow. A list of available fonts appears. This list of fonts is
arranged in alphabetical order.

2. Click Courier New. The name of the new font is dis-
played in the Font box.

3. Press the Enter key three times.
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4. Click the Insert tab, then click Date & Time. The Date
and Time dialog box appears.

5. Click the third option in this list—the standard long date
that typically appears in business correspondence. Your
dialog box should display the current date.

6. Click Update automatically to select this option.

7. Click OK. The current date appears in the document.

8. Press the Enter key three times.

9. Type the text shown here.

I am writing to introduce you to Natural Crystals and Fossils—a truly unique
profit-boosting opportunity for your company.¶

¶
If you currently feature crystals, fossils, or semiprecious gemstones in
your store, then I don’t need to tell you about the great profits these
items will generate. You’ve already seen how customers of all ages seem mag-
netically drawn to a crystal or polished gemstone. Once they become
attracted to a particular item, they often make an impulse purchase after
just a few minutes. Because of their intrinsic beauty and value, fossils and
minerals are popular as gift items, souvenirs, and collectibles.¶
¶
Natural Crystals and Fossils offers a dazzling variety of crystals, fossils,
and minerals in a wide range of prices. After you see our quality offerings
and modest pricing, I know you’ll want to place an order. Or, contact me at
(988) 555-1243 to learn more about how Natural Crystals and Fossils can help
you increase profits.¶
¶
Sincerely,¶
¶
¶
¶
Jerry Villard¶

President¶
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Saving Your Letter
The basic text portion of your form letter is now complete.
Compare your screen to Figure 47.

Natural Crystals and Fossils
1411 Sunset Trail
Pryor, OK 74361

March 21, 2013

I am writing to introduce you to Natural Crystals and Fossils—a truly unique
profit-boosting opportunity for your company.

If you currently feature crystals, fossils, or semiprecious gemstones in your
store, then I don’t need to tell you about the great profits these items will
generate. You’ve already seen how customers of all ages seem magnetically
drawn to a crystal or polished gemstone. Once they become attracted to a par-
ticular item, they often make an impulse purchase after just a few minutes.
Because of their intrinsic beauty and value, fossils and minerals are popular
as gift items, souvenirs, and collectibles.

Natural Crystals and Fossils offers a dazzling variety of crystals, fossils,
and minerals in a wide range of prices. After you see our quality offerings
and modest pricing, I know you’ll want to place an order. Or, contact me at
(988) 555-1243 to learn more about how Natural Crystals and Fossils can help
you increase profits.

Sincerely,

Jerry Villard
President

FIGURE 47—Type the text portion of your form letter.
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After you’ve checked your text, take a moment to name and
save your letter.

1. Click Save. The Save As screen appears with the
Documents folder listed among the destinations. Select
the Documents folder.

2. Type the filename Mailing Letter in the File Name box.

3. Click on Save. This saves your form letter on your com-
puter’s hard disk.

Now move directly to the next section to add addresses from
your database.

Inserting Merge Fields
In your main document, you must insert merge fields to
instruct Word where to put information from your data
source. Once you’ve inserted these fields, Word will create
your form letters for you.

Follow these steps to insert merge fields into your main
document.

1. Click to move your insertion point immediately to 
the left of the date.

2. Press the Down Arrow key twice to move the 
insertion point down two lines.

3. Click Address Block in the Mail Merge panel
(Figure 48).

4. Make sure your Insert Address Block selections
appear as in Figure 49 and then click OK.

5. Press the Enter key twice.
Now follow these steps to create a personalized  greeting.

1. Click Greeting Line in the Mail Merge pane.

2. Leave the default selection and then click OK.
3. To save your work, click the Save button.

Your form letter should now look much like the one in 
Figure 50. 

FIGURE 48—You insert Merge

fields from the Mail Merge

pane.
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Previewing Your Letters
Now you’re going to preview your letter merged with your
mailing list.

1. Click Next: Preview Your Letters in the Mail Merge
pane. Word merges the letter with the database records
to create a new three-page document.

2. Click the double-arrow in the Mail Merge pane to pre-
view your letters.

3. Click Next: Complete The Merge. You’ve now com-
pleted the Mail Merge. You can print or edit individual
letters if you would like.

4. Close the Mail Merge pane.

5. Save your file.

6. Click the Word window’s Close button to exit the appli-
cation.

7. If a dialog box appears asking whether you want to save
changes to Mailing Letter, click the Yes button.

FIGURE 49—Use the selections here for your Address Merge field.
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Natural Crystals and Fossils
1411 Sunset Trail
Pryor, OK 74361

March 21, 2013

<<AddressBlock>>

<<GreetingLine>>

I am writing to introduce you to Natural Crystals and Fossils—a truly
unique profit-boosting opportunity for your company.

If you currently feature crystals, fossils, or semiprecious gemstones
in your store, then I don’t need to tell you about the great profits
these items will generate. You’ve already seen how customers of all
ages seem magnetically drawn to a crystal or polished gemstone. Once
they become attracted to a particular item, they often make an
impulse purchase after just a few minutes. Because of their intrinsic
beauty and value, fossils and minerals are popular as gift items,
souvenirs, and collectibles.

Natural Crystals and Fossils offers a dazzling variety of crystals,
fossils, and minerals in a wide range of prices. After you see our
quality offerings and modest pricing, I know you’ll want to place an
order. Or, contact me at (988) 555-1243 to learn more about how
Natural Crystals and Fossils can help you increase profits.

Sincerely,

Jerry Villard
President

FIGURE 50—This is what your form letter should look like after you’ve inserted the merge fields.
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Your integrated form letter is now complete (Figure 51). You
now know how to produce a personalized mailing that’s
effective and professional looking. You can quit Windows
now to end your work session or move directly to the next
section to add new information to your mail merge database.

Updating a Mailing List
Most databases are long-term projects that grow and change
on a regular basis. A mailing list is a classic example of this
type of ongoing project. Addresses, job titles, phone numbers,
and fax numbers can change rather quickly. You should
make a note of these changes as soon as you become aware
of them. Once you’ve accumulated even a few corrections for
your address list, update the file at that time. A mailing list
is only as good as the data it contains. It can be frustrating
to waste postage (and lose time) because the postal service
has to return or forward letters incorrectly addressed.

Let’s assume that just before you print your letters, you hap-
pen to see a news blurb announcing that Faraway Gifts has
relocated to an expanded office space. The blurb also reports
that Darnell Winston has been promoted to Director of the
Product Evaluation department. Follow these steps to open
your database so you can update its information.
1.  Open Microsoft Access.
2.  Under Recent, click Mailing. (If it’s not visible, click
Open Other Files, and locate the file in your
Documents folder.) The Mailing window appears.

3.  Double-click Mailing under Tables. The Mailing data-
base appears in Form View.

Finding a Record

In a large database, you should really use the Find command
to conveniently and quickly locate records you wish to
update or delete. Although your database is relatively small,
use Find to locate Darnell Winston’s record by searching in
the Last Name field.
1.  To move to the top of the file, press the Ctrl+Home key

combination.
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Natural Crystals and Fossils
1411 Sunset Trail
Pryor, OK 74361

March 21, 2013

Mr. Abner Corvell
Cactus Gifts and Novelties
255 Mesa Drive
Tempe, AZ 05201-2114

Dear Mr. Corvell,

I am writing to introduce you to Natural Crystals and Fossils—a truly
unique profit-boosting opportunity for your company.

If you currently feature crystals, fossils, or semiprecious gemstones
in your store, then I don’t need to tell you about the great profits
these items will generate. You’ve already seen how customers of all
ages seem magnetically drawn to a crystal or polished gemstone. Once
they become attracted to a particular item, they often make an impulse
purchase after just a few minutes. Because of their intrinsic beauty
and value, fossils and minerals are popular as gift items, souvenirs,
and collectibles.

Natural Crystals and Fossils offers a dazzling variety of crystals,
fossils, and minerals in a wide range of prices. After you see our
quality offerings and modest pricing, I know you’ll want to place an
order. Or, contact me at (988) 555-1243 to learn more about how
Natural Crystals and Fossils can help you increase profits.

Sincerely,

Jerry Villard
President

FIGURE 51—Here’s your first letter with fields merged from your address list.
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2.  Click in the Last Name field (which now displays the
name Corvell).

3.  Click Edit in the menu bar.

4. Click Find in the Home tab. A dialog box appears in
which you can specify the field in which to search and
the text you want to find (Figure 52).

5. Type the name Winston in the Find What box.

6. Click on the Find Next button. With the Last Name field
selected, doing so displays Darnell Winston’s record. Note
that the label Record 3 of 3 is displayed in the lower left-
hand corner of the database window.

7. Click Cancel to exit the Find dialog box.

Correcting Field Entries

1. Press the Tab key. The cursor advances to the 
Job Title field.

2. Type the new job title: Director.

3. Press the Tab key three times to advance to the 
Address field.

4. Type the new street address: 200 Wingate Avenue.

5. Press the Enter key.

6. Click the Save button.

You can see that Access makes it easy to quickly locate and
correct any record in the database.

FIGURE 52—Use the

Find dialog box to

locate a specific record.
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Using OfficeLinks
Now follow these steps to merge your mailing letter with the
updated database and thus create a new document.

1. Close Mailing to exit the database form.

2. Double-click Mailing under Tables to open the database.

3. From the External Data tab, click Word Merge.

5. The Microsoft Word Mail Merge Wizard dialog box
appears, asking whether you want to link the database
to an existing document or create a new document
(Figure 53).

6. Click Link your data to an existing Word  document.

7. Click OK. The Select Microsoft Word Document dialog
box appears.

8. Click Mailing Letter to select this document.

9. Click Open. Microsoft Word opens and displays your
form letter.

10. Follow the steps in the Mail Merge pane to create the
new mailing list:

• Keep Mailing as your existing list

• Click Next: Write your letter.

FIGURE 53—The Microsoft

Word Mail Merge Wizard 

displays merge options.
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• Click Next: Preview your letters.

• Preview your letters to make sure your changes
appear as you would like. Click the right arrow 
button twice in the Mail Merge pane and make 
sure Darnell Winston’s information has been
updated as in Figure 54. 

• Click Next: Complete The Merge.

11. Click Save to save your changes.

12. Click the Word window’s Close button to exit the appli-
cation. An information dialog box appears.

13. Click Yes to save Mailing Letter.

14. If the Access window appears, click the Access window’s
Close button to exit that application.

You’ve worked hard to create a terrific mailing and should
now feel rather comfortable merging a database with a letter
and updating your work as needed. The ability to create
 multiple personalized letters (and other merge documents) is
an important asset to any business, school, club, or commu-
nity group.

Take the time to think of ways that this type of integrated file
might help you to meet some of your own personal goals. Some
families keep in touch by sending a regular “newsletter” to rela-
tives and friends. Community organizations often send mailings
as part of an outreach program or fund-raising campaign, or
they may use form letters to update their members about cur-
rent activities. Form letters are also a great way to obtain
information from companies who provide products or services
that interest you. Creating a mailing is a convenient way to
focus on an important goal and get your message across.

You’ve covered a lot of ground in this study unit. You’ve
learned the difference between embedding and linking, and
you’ve studied the procedures for performing these functions.
You’ve also completed a sample project involving one of the
most popular integrated applications today—Mail Merge.

It’s time to review the final section by completing Self-Check 3.
When you’ve finished that self-check, review the entire study
unit in preparation for the examination.
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Natural Crystals and Fossils
1411 Sunset Trail
Pryor, OK 74361

March 21, 2013

Mr. Darnell Winston
Faraway Gifts
200 Wingate Avenue
Monrovia, CA 91016-1324

Dear Mr. Winston,

I am writing to introduce you to Natural Crystals and Fossils—a truly
unique profit-boosting opportunity for your company.

If you currently feature crystals, fossils, or semiprecious gemstones
in your store, then I don’t need to tell you about the great profits
these items will generate. You’ve already seen how customers of all
ages seem magnetically drawn to a crystal or polished gemstone. Once
they become attracted to a particular item, they often make an impulse
purchase after just a few minutes. Because of their intrinsic beauty
and value, fossils and minerals are popular as gift items, souvenirs,
and collectibles.

Natural Crystals and Fossils offers a dazzling variety of crystals,
fossils, and minerals in a wide range of prices. After you see our
quality offerings and modest pricing, I know you’ll want to place an
order. Or, contact me at (988) 555-1243 to learn more about how
Natural Crystals and Fossils can help you increase profits.

Sincerely,

Jerry Villard 
President

FIGURE 54—The form letter to Darnell Winston reflects the changes you made in the database.



Integrating Word with Access and Excel64

Self-Check 3
1.  Before you can begin to enter records into a new database, you must 

a. open Excel.                                                    c.   create a table.

b. create a worksheet.                                        d.  create a form.

2.  What would the field placeholder for a database field named Company look like after you

inserted it into a Word document?

a. Company:                                                      c.   <<Company>>

b. **Company**                                                d.  Field:Company

3.  In what application(s) can you create a database for a mail merge?

        __________________________________________________________

Check your answers with those on page 65.
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Self-Check 1
1. a

2. c

3. b

4. d

5. a

Self-Check 2
1. False

2. Insert button

3. Currency style button

4. The sum of the amounts in cells C2 and D2

5. Aim the mouse pointer at one of the worksheet’s resizing
handles, and then click-and-drag the worksheet to the
desired size.

Self-Check 3
1. c

2. c

3. Your text mentions Word, Excel, and Access, which can
be used to create databases for mail merges.
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